Adobe PDF forms can be created in Acrobat Standard (Windows) and Acrobat Pro using the form tools and many commands for creating a different kind of form. XML forms are created in Adobe Designer and Acrobat PDF forms are created in Acrobat (Standard or Pro). In some cases, an Acrobat PDF form might be preferred over an XML form. These two form types are distinctive in both the creation process and the intended use.

Before you delve into this chapter, realize that creating both Acrobat forms and Adobe LiveCycle Designer forms covers as much territory as the complete Adobe Acrobat X PDF Bible. As a matter of fact, I’ve written a book titled PDF Forms Using Adobe Acrobat and LiveCycle Designer Bible (Wiley Publishing 2009). That book equals the size of the Adobe Acrobat X PDF Bible. Therefore, all I can hope to do in this chapter is give you a brief introduction to creating PDF forms. No coverage for Adobe LiveCycle Designer appears in this book. To learn how to use LiveCycle Designer, look to the PDF Forms Using Adobe Acrobat and LiveCycle Designer Bible.

In this chapter, you learn how to use Form Edit Mode and create PDF forms in one of the Acrobat viewers, and find an introduction to using the different form tools. The good news is you can create PDF forms in Acrobat on either Windows or the Macintosh.

**Exploring Acrobat Forms**

*Forms* in Acrobat are PDF files with data fields that appear as placeholders for user-supplied data. In Acrobat, you can use text string fields, numeric fields, check boxes, radio buttons, date fields, calculation fields,
Part VI: Using Acrobat PDF Forms

signature fields, and a variety of custom fields created with JavaScripts. The advantage of using forms in Acrobat is that doing so enables you to maintain design integrity for the appearance of a form while providing powerful control over data management. Rather than using a database manager, which may limit your ability to control fonts and graphics, Acrobat PDFs preserve all the design attributes of a document while behaving like a data manager.

PDF Workflow
Forms are created in Acrobat or Adobe Designer. Form field data can be saved with Acrobat and also with Adobe Reader when the PDF form has been enabled with usage rights for Adobe Reader. When opening PDFs in Adobe Reader that have not been enabled with Reader Extensions, you cannot save, import, or export data. In developing PDF workflows for a company or organization, all users expected to design forms in Acrobat need to use one of the Acrobat software applications. Corporations and enterprises seeking an affordable solution for extending Adobe Reader to support forms features beyond the licensing limitations of Acrobat should look at acquiring the Adobe LiveCycle Reader Extensions ES (). For more information about LRES, log on to www.adobe.com/products/livecycle/readerextensions/.

Cross-Reference
See Chapter 18 for more information on enabling PDFs for filling in and saving forms in Adobe Reader, and also for information on licensing restrictions applied to the use of enabling features in Acrobat.

Recognizing the non-PDF form
The one thing to keep in mind regarding Acrobat and forms is that a form in the context of PDF is not a paper form scanned as an image and saved as PDF. Tons of these so-called forms are around offices and on the Internet. These documents may have originated as forms, but by the time you understand all of Acrobat’s form creation features, you’ll see that these scanned documents can hardly be called forms. Simply put, they’re scanned images saved to PDF. The power of Acrobat gives you the tools to create smart forms. These forms can be dynamic, intuitive, and interactive, and save both you and the recipient much time in providing and gathering information.

Developing a PDF form
PDF forms created in Acrobat usually start out as a document converted to PDF from an authoring program. Programs like Microsoft Office, Adobe InDesign, Adobe Illustrator, or one of your favorite design programs creates the layout and background for a PDF form. After the design is created in an authoring program and converted to PDF, you use tools in Acrobat to add form field objects and form field attributes.

Cross-Reference
For information related to PDF creation from authoring programs, see the chapters in Part II.
Chapter 30: Understanding Acrobat Form Tools

**Tip**
If you create a design and then add form fields in Acrobat, and then even later decide to change your design, you can edit the design back in your original authoring application. Simply save the design and open the form you created in Acrobat. Open the Pages panel, click Replace Pages, and select the modified PDF document. Replace the page, and your modified design appears without disturbing any added form fields on the original design.

**Filling in PDF Forms**
When you receive or download a PDF form, you will encounter one of two types of forms. The so-called PDF form that was created from a scanned document or a PDF document containing no form fields is one type of form. The other type of form is the PDF document containing form fields. In all Acrobat viewers you can populate form data in either type of form.

**Using the Typewriter tool**
The Typewriter tool is used to fill in a form containing no form fields. You use the Typewriter tool like a text tool is used in other authoring programs.

To use the Typewriter tool, open the Content panel and click Add or Edit Text Box. Click the page where you want to type text and an I-beam cursor appears. Type the text on a line. To adjust properties for the text you add with the Typewriter tool, click Text Box Formatting Tools in the Content panel.

The tools in the Typewriter toolbar from left to right, as shown in Figure 30.1, include the Typewriter tool, the Text Smaller tool, the Text Larger tool, Decrease Line Spacing tool, Increase Line Spacing tool, Text Color, a pull-down menu listing all your installed system fonts, and a choice for font sizes. If you want to move a text block after typing, use the Select Object tool.

![Figure 30.1](#)
Click the Typewriter tool and click a page to type text.

You have a number of options from a context menu you open using the Select Object tool on type added with the Typewriter tool. Text blocks can be aligned, centered, distributed, and sized the same as the options you find when managing field objects.

**Cross-Reference**
For more information on using the context menu commands, see “Managing fields” later in this chapter.
Part VI: Using Acrobat PDF Forms

Using the Comments panel
The Typewriter tool adds annotations to your document. The text you type with the tool is not text applied to the document the same as when using other options available to you for adding text. Each line of type you add with the Typewriter tool adds the type as an annotation, and the annotations can be viewed and selected in the Comments panel. Type a few lines of text with the Typewriter tool and click Comments in the toolbar to open the Comments panel, and you see a view like the one shown in Figure 30.2.

FIGURE 30.2
Click Comments in the toolbar to open the Comments panel and you see a list of the entire Typewriter text added to your file.

The Comments panel list of the Typewriter additions can be very handy when editing a document. If you want to delete a line of type, click the line in the Comments panel and click the Trash icon or press the Del key on your keyboard. You can also edit the type directly in the Comments panel and the changes are applied to the document page.

Cross-Reference
For more information on annotations and using the Comments panel, see Chapter 19.

Filling in forms containing form fields
As you view the form shown in Figure 30.3, notice it contains several text fields, a few combo boxes, a list box, radio buttons, check boxes, and a signature field. To fill out a text field, you need to select the Hand tool, place the cursor over the field, and click the mouse button. When you click, a blinking I-beam cursor appears, indicating that you can add text by typing on your keyboard.
Chapter 30: Understanding Acrobat Form Tools

**Figure 30.3**
A form containing many different field types: A) text fields, B) radio buttons, C) check boxes, D) combo box, E) list box, and F) signature field.

**Tip**
To begin filling in a form, press the Tab key on your keyboard. When the Hand tool is selected and the cursor is not active in any field, pressing the Tab key places the cursor in the first field on the form.

To navigate to the next field for more text entry, you can make one of two choices: Click in the next field or press the Tab key on your keyboard. When you press the Tab key, the cursor jumps to the next field, according to an order the PDF author specified in Acrobat when the form was designed. Be certain the Hand tool is selected and a cursor appears in a field box when you press the Tab key. If you have any other tool selected, you can tab through the fields and type data in the field boxes; however, if you click with the mouse when another tool is selected, you make edits according to the active tool.

When selecting from choices in radio button or check box fields, click in the radio button or check box. The display changes to show a small solid circle or check mark within a box or other kind of user-defined symbol from options you select for button/check box styles. When using a combo box, click the down-pointing arrow in the field and select from one of several pull-down menu choices. List boxes are scrollable fields. Scroll to the choice you want to make using the up and down arrows.
Part VI: Using Acrobat PDF Forms

Looking at form field navigation keystrokes
As mentioned in the preceding section, to move to the next field, you need to either click in
the field or press the Tab key. Following is a list of other keystrokes that can help you move
through forms to complete them:

- Shift+Tab. Moves to the previous field.
- Esc. Ends text entry.
- Return. Ends text entry for single line entries or adds a carriage return for multi-line
  fields.
- Double-click a word in a field. Selects the word.
- Ctrl/⌘+A. Selects all the text in a field.
- Left/Right Arrow keys. Moves the cursor one character at a time left or right.
- Up Arrow. Selecting options in the combo and list boxes moves up the list.
- Down Arrow. Selecting options in the combo and list boxes moves down the list.
- Up/Down Arrow with combo and list boxes selected. Moves up and down the list.
  When the list is collapsed, pressing the Down Arrow key opens the list.
- Ctrl/⌘+Tab. Accepts new entry and exits all fields. The next tab places the cursor in
  the first field.

Viewing fields
You may open a form in Acrobat where the fields are not clearly visible. Creating form fields
on white backgrounds for fields with no border or fill color makes a field invisible when
opened in an Acrobat viewer.

If you start to fill in a form and can’t see the form fields, click the Highlight Fields button on
the Document message bar. All fields are highlighted with a color specified in the Forms
Preferences. In Figure 30.4, the fields are white. When I click the Highlight Fields button in
the top-right corner of the Document message bar, the fields are highlighted, making it easy
to see where each field appears in the form.

If you don’t see the Document message bar, you need to adjust a preference setting. Press
Ctrl/⌘+K to open the Preferences dialog box. Click Forms in the left pane and remove the
check mark where you see Always hide forms document message bar. Remove the Always
hide forms document message bar check box as shown in Figure 30.5 to display the message
bar in the Document pane.

Using Auto-Complete features
While filling in a form, you can enable Acrobat to record common responses you supply in
form fields. After recording responses, each time you return to similar fields, the fields are
automatically filled in or a list is offered to you for selecting an option for auto-completing
fields.
Chapter 30: Understanding Acrobat Form Tools

FIGURE 30.4
Click Highlight Fields in the Document message bar to display fields with highlights.

FIGURE 30.5
Remove the Always hide forms document message bar check box to display the message bar in the Document pane.

To turn the recording mechanism on, you need to address the Forms preference settings. Open the Preferences dialog box by pressing Ctrl/⌘K and select Forms in the left pane. In the right-hand pane, open the pull-down menu under the Auto-Complete section of the Forms preferences. You can make menu choices from Off, Basic, and Advanced, as shown in Figure 30.6. Selecting Off turns the Auto-Complete feature off. Selecting Basic stores information entered in fields and uses the entries to make relevant suggestions. Select Advanced from the pull-down menu to receive suggestions from the stored list as you tab into a field. If a probability matches the list, using the Advanced option automatically fills in the field when you tab into it.
Part VI: Using Acrobat PDF Forms

FIGURE 30.6
Click Forms in the Preferences dialog box and select Basic or Advanced from the Auto-Complete pull-down menu to use the auto-completion feature.

By default, numeric data are eliminated from the data stored for the suggestions. If you want to include numeric data for telephone numbers, addresses, and the like, check the Remember numerical data check box.

The list grows as you complete forms when either the Basic or Advanced choice is enabled in the pull-down menu. You can examine the list of stored entries by clicking the Edit Entry List button; the Auto-Complete Entry List dialog box opens as shown in Figure 30.7. To remove an item from the list, select it and click the Remove button. To remove all entries, click the Remove All button.

FIGURE 30.7
To remove entries from your suggestion list, click the Edit Entry List button in the Forms preferences. Select items in the Auto-Complete Entry List and click the Remove button.
Chapter 30: Understanding Acrobat Form Tools

In order to record entries, you need to first make the selection for using either the Basic or Advanced Auto-Complete feature. To have suggestions for entries submitted as you type in fields, one of the two menu options needs to be enabled. When you select Off in the pull-down menu, both recording entered data and offering suggestions are turned off.

After selecting either Basic or Advanced in the Forms preferences and editing entries, fill out a form. If you recorded data after filling out one form, the next time you fill out another form you’ll see suggestions, as shown in Figure 30.8. The cursor appears just below City and the suggestion (Fairways) is derived from recorded data supplied on another form.

![Figure 30.8](image)
Enter a field and a data suggestion(s) appears in a pull-down menu.

How good is the Auto-Compete feature in Acrobat? When the feature was first introduced several generations ago, it was pretty clumsy. There wasn’t much sophistication in controlling what data were recorded and what data were suggested when filling in a form. After several Acrobat revisions, there remain no changes in the Auto-Fill feature. It’s still quite clumsy, and you’ll find sometimes it may work well for you, and in other cases you’ll find turning off the Auto-Fill option less distracting when completing a form.

Working in the Form Editing Environment

Up to this point I’ve covered filling in PDF forms as you might do in Adobe Reader or Adobe Acrobat. Let’s shift gears now and take a look at how we create a PDF form in Acrobat — remember, the options listed here are available to you in the Acrobat commercial products including Acrobat Standard (Windows) and Acrobat Pro (Windows and Mac). If you’re an Acrobat Standard user, there are no limitations you find when authoring forms in Standard. All the tools and features are identical in Acrobat Standard as they are in the Acrobat Pro products.

To enter Form Editing Mode, you begin by opening the Forms panel and clicking Start Form Wizard. This command is available to you even when you don’t have a document open in the Document pane. If a document is open in the Document pane, you can also click Add or Edit Fields in the Forms panel. Choosing either command opens a PDF file in Form Editing Mode.
Part VI: Using Acrobat PDF Forms

Starting the Form Wizard

When you click Start Form Wizard, the Create or Edit Form Wizard opens in Acrobat. Again, you can start the Wizard with or without a file open in the Document pane. Figure 30.9 shows the Wizard as it appears on Windows (left) and the Mac (right).

![Figure 30.9](image)

The Create or Edit Form Wizard provides different options for Windows and Mac users.

You find two options in the Wizard for creating a PDF form. Your options include:

- **An existing electronic document (Windows)/Start with a PDF document (Mac).** On Windows, you can begin with a native MS Office file, a PDF, or other file format that can be converted to PDF consistent with your viewer’s support for converting documents to PDF via the File ➤ Create ➤ PDF From File command. Acrobat performs three functions when you choose a file format other than PDF. Your native file is first converted to PDF, and Acrobat’s auto field detection operation is invoked, where Acrobat automatically recognizes fields on the form, and the form opens in Form Edit Mode.

  On the Mac, you don’t have options for converting MS Office applications and several other file formats. Hence, you must begin with an existing PDF document.

- **A paper form.** Choosing this option performs several steps. Acrobat Scan is chosen where you can scan a paper document, the Recognize Text Using OCR command is invoked where the scan is converted to rich text, auto field detection is invoked, and the form opens in Form Editing Mode.

**Cross-Reference**

For more information on using Acrobat Scan and the Recognize Text Using OCR command, see Chapter 16.

**Cross-Reference**

For more information on using Adobe LiveCycle Designer, see the PDF Forms Using Acrobat and LiveCycle Designer Bible (Wiley Publishing 2009).
Chapter 30: Understanding Acrobat Form Tools

Adding or editing fields
Your second choice for entering Form Editing Mode is to use the Add or Edit Fields command in the Forms panel. This option is only available when you have a PDF file open in the Document pane. You can open a PDF file without any fields, choose the Add or Edit Fields command, and Acrobat immediately assesses the document. If no form fields exist on the document, a dialog box opens asking you if you want Acrobat to detect form fields for you. If you click Yes in the dialog box, auto field detection populates the form. The form then opens in Form Editing Mode. If you click No in the dialog box, the form opens in Form Editing Mode, where you can manually edit the form by drawing field objects on the page.

Changing modes
When you choose either the Create or the Edit command from the Forms panel, you eventually end up in the Form Editing Mode. As you can see in Figure 30.10 this mode is a completely different view as the standard Viewer mode in Acrobat in what I refer to as the Viewer mode. In this viewer interface you find several options via buttons and menus that include:

**FIGURE 30.10**
The Form Editing Mode displays a completely different interface than Acrobat's standard Viewer mode.
Part VI: Using Acrobat PDF Forms

A. **Menu bar.** The same menu items are listed in the menu bar as you find in the Viewer mode. However, very few menu items can be selected when in Form Editing Mode.

B. **Form Editing Tools.** All the form tools are located in the QuickTools toolbar.

C. **Preview.** Click Preview and your form appears as a recipient will see it. In Preview you can add data to form fields, and check tab order, calculations, and other items to verify that the form field objects behave as you designed them. You still remain in Form Editing Mode when you choose this option, but the form changes from an editing view to a recipient view.

D. **Forms Tasks.** The Add New Field pull-down menu offers you all the form tools that were previously available in earlier Acrobat toolbars and also available in the QuickTools toolbar (item B above). There is no separate toolbar for form tools in Acrobat X. The only way to manually add a field is to enter the Form Editing Mode and choose a tool from this menu or expand the toolbar in the Form Editing Mode Toolbar Well.

E. **Close Form Editing.** Click this button to leave Form Editing Mode and return to Viewer mode. The only way to return to Form Editing Mode is to click Add or Edit Fields in the Forms panel.

F. **Form Fields.** The Form Editing Mode is the only place you’ll find the Fields panel. You cannot access the panel in Viewer mode. To view the list of fields on a form, open the Forms panel and click Add or Edit Fields. Fields are shown listed in the Forms Fields panel.

**Editing according to mode**

One thing to keep in mind is that Form Editing Mode is the place you want to use for applying fields. Most of the other kinds of editing you do with form fields can be handled in the Viewer mode. For example, if you create a text field, you first enter Form Editing Mode and create your field. Once the field is created, you can exit Form Editing Mode and make adjustments to the field properties.

Table 30.1 shows a list of the kinds of edits you can make respective to Form Editing and Viewer modes.

<table>
<thead>
<tr>
<th>Table 30.1</th>
<th>Form Editing According to Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Editing Task</strong></td>
<td><strong>Viewer Mode</strong></td>
</tr>
<tr>
<td>Access form tools</td>
<td>X</td>
</tr>
<tr>
<td>Copy/paste fields</td>
<td>X</td>
</tr>
<tr>
<td>Align/size/distribute/delete fields</td>
<td>X</td>
</tr>
</tbody>
</table>
Chapter 30: Understanding Acrobat Form Tools

<table>
<thead>
<tr>
<th>Editing Task</th>
<th>Viewer Mode</th>
<th>Form Editing Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place multiple fields</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Assign actions to fields</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Distribute form</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Compile form data</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Show tab numbers</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Import/export form data</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Merge data into spreadsheets</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Track forms</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Clear form data (menu command)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>JavaScripts (Debugger, Edit All, Document, Set Document Actions)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Highlight fields</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Page templates</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

Creating a PDF Form

You have three means for creating an AcroForm — that is, a form created in Acrobat. You can start with a form design where fields are clearly identified with design elements such as lines and boxes, you can scan a paper form, and you can add form field objects from scratch using the form tools. For the first two options, you let Acrobat automatically add field objects through auto detecting fields that are invoked when you enter Form Editing Mode. Using the third option assumes Acrobat cannot detect any fields on a form design and you need to manually add all the field objects.

Using auto field detection

You have a choice for how you want to open your form design. If you have an original design in a program like MS Word on Windows, you can choose to open the original Word document in Acrobat. Acrobat will convert your Word document to a PDF file, open the Form Editing Mode, and automatically detect field objects. It’s all accomplished in one step, making conversion of files like MS Word, Adobe InDesign, and a host of other file formats to PDF forms a super-easy task.

Let’s take a minute to see how easy it is to convert a Microsoft Office document to a PDF form by following these steps.

**STEPS: Converting a Document to a PDF Form**

1. **Start the Form Wizard.** Open the Forms panel and click Create to open the Create or Edit Form Wizard shown earlier in Figure 30.9. Using this command presumes
you have a form design saved from a Microsoft Office application or other file format compatible with creating a PDF from within Acrobat (Windows).

If you’re a Mac user, you need to begin with a PDF document. If you have an Office file, convert the file to PDF before using the Form Wizard.

2. **Select the file to convert.** In the Create or Edit Form Wizard click the Next button and click Browse to locate a file. Locate a file and click Next. Acrobat will convert the file, open the document in Form Editing Mode, and use auto field detection.

   Mac users can select a PDF document in the Create or Edit Form Wizard and the PDF document opens in Form Editing Mode, and auto field detection is automatically invoked.

3. **Review the Welcome to Form Editing Mode welcome dialog box.** When you enter Form Editing Mode and Acrobat automatically detects field objects, a welcome dialog box opens as shown in Figure 30.11. This dialog box offers some information about creating form field objects in Form Editing Mode. Look over the information and click OK. After you become familiar with creating forms in Acrobat, you can click the Don’t show again check box to prevent the dialog box from opening in future form-editing sessions.

   ![FIGURE 30.11](image-url)

   Look over the information in the Welcome to Form Editing dialog box and click OK.

   You are in Form Editing Mode. To access more Acrobat tools choose “Close Form Editing” in the right hand pane.

   Acrobat searched through “seminarRaw.pdf” and automatically detected the form fields.

   ![Form Editing](image-url)

4. **Review the form.** After auto detecting fields on your form, you should always look over the form to be certain all fields were properly added. Although auto detection does a great job in adding fields to a form, it’s not perfect, and you can often find a little polish is needed to finalize the form. In my example, I have a few problems on my form.

   Two extra fields were added to the form where form field objects shouldn’t appear, as shown in Figure 30.12. These fields need to be deleted. The first row of boxes is check box fields that should be radio buttons designed as mutually exclusive fields. As one button is checked, the others should remain unchecked. The second row of fields is radio buttons, but they are not designed as mutually exclusive fields.
5. **Delete unnecessary fields.** Locate any fields that were created and not needed on your form. Click a field and press the Del or Backspace key to remove a field object. If you intend to redesign radio buttons or check boxes, delete all the buttons/check boxes in a row by dragging through the objects and pressing the Del or Backspace key.

6. **Add radio button fields.** Open the Add New Field pull-down menu and select the Radio Button tool. Move the tool to the location on the form where you want to add a radio button and click the mouse to drop the field on the page.

7. **Name the field and set the button value.** A mini properties box opens when you add a field to a page. You can type a name for the field and set a button value when adding radio buttons to a form. In Figure 30.13, I name my new radio button field seminarDate, and I set the button value to May 1.

8. **Add a new field.** Click Add another button to group and the cursor changes to a crosshair. Click or click+drag to place another button field on the page. By default, your field name remains the same. Just type another Button Value for the field. By adding buttons (or check boxes) with the same name and changing the values, you create a mutually exclusive set of radio buttons (or check boxes).
Part VI: Using Acrobat PDF Forms

9. **Preview the form.** Click Preview and add data to all your field objects. Be certain the fields are designed properly and the data you add to the form conforms properly to your form design.

10. **Save the form.** Choose File → Save As → PDF and rewrite the file. If you save periodically, rewriting the file reduces the final file size.

**Tip**
While working on a form you may need to zoom in and scroll the screen to display hidden areas of your form. While in Form Editing Mode you don’t have a Hand tool to scroll the window. To gain temporary access to the Hand tool, press the Spacebar and drag the screen to display hidden areas.

**Scanning paper forms**
Converting paper forms to electronic forms is performed by first using Acrobat Scan to scan a document into a PDF file. When you open the Create or Edit Form Wizard and click the Scan a paper form radio button and then click Next, the Acrobat Scan dialog box opens as shown in Figure 30.14.
Chapter 30: Understanding Acrobat Form Tools

The first step in converting a paper document is to scan it using Acrobat Scan. The choices you have for scanning from within Acrobat via Acrobat Scan are all covered in Chapter 16. Look over that chapter if you want more information on scanning in Acrobat.

If you do use Acrobat Scan to convert a paper form to PDF, Acrobat automatically runs the internal OCR feature and converts the scan to rich text. From there, the file opens in Form Editing Mode and fields are automatically added via auto field detection.

You have the same issues to deal with converting a paper form to PDF as you do when converting a file to PDF in regard to the field objects. Look over the form while in Form Editing Mode and delete any unwanted fields. Be sure to double-check the form to see if all fields have been added, and check the radio buttons and check boxes for mutually exclusive fields. Like other forms you create in Acrobat, it’s a good idea to check the fields in Preview mode to be certain all fields are formatted properly.

Creating field objects manually

Forms contain different types of data fields that hold data, act as buttons that invoke actions, and call scripts to execute a series of actions. Form fields can assume different appearances as well as possess the capability to include graphic icons and images to represent hot links that invoke actions. Acrobat forms are more than a static data filing system — they can be as vivid and dynamic as your imagination.

In Acrobat, the form data fields are created by making selections from the Add New Field pull-down menu in the Forms panel in Form Editing Mode. Making a menu choice loads the cursor with a tool you use to either click the form where a field is to be placed at a default size or click and drag the cursor to create a custom size.

For an overview of the field types, look over the following list:

- **Button.** A button is usually used to invoke an action or hyperlink. A button face can be text or a graphic element created in another program that you could apply as an appearance to the button. You can also use different appearance settings in the button properties for adding stroke and fill colors. Buttons are also used to import images.

- **Check Box.** Check boxes typically appear in groups to offer the user a selection of choices. Yes and no items or a group of check boxes might be created for multiple-choice selections.

- **Combo Box.** When you view an Acrobat form, you may see a down-pointing arrow similar to the arrows appearing in panel menus. Such an arrow in a PDF form indicates the presence of a combo box. When you click the arrow, a pull-down menu opens with a list of choices. Users are limited to selecting a single choice from combo boxes. Additionally, if designed as such, users can input their own choices.

- **List Box.** A list box displays a box with scroll bars, much like windows you see in application software documents. As you scroll through a list box, you make a choice of one or more of the alternatives available by selecting items in the list.
Part VI: Using Acrobat PDF Forms

- **Radio Button.** Radio buttons perform the same function in PDF forms as radio buttons do in dialog boxes. Usually you have two or more choices for a category. Forms are usually designed with radio buttons offering mutually exclusive choices so that when one radio button in a group is turned on, the other buttons in the group are turned off.

- **Text Field.** Text fields are boxes in which the end user types text to fill out the form. Text fields can contain alphabetical characters, numbers, or a combination of both.

- **Digital Signature.** Digital signatures can be applied to fields, PDF pages, and PDF documents. A digital signature can be used to lock out fields on a form.

- **Barcode.** The Barcode tool was not a completely new feature in Acrobat 8. Acrobat 7 supported a plug-in to create 2-D and 3-D barcodes that was shipped long after the initial release of Acrobat 7.0. With Acrobat 8.0 and above, you get the Barcode tool appearing in the Forms toolbar. This tool provides you with options for adding barcodes to a PDF form.

All these form field types and tools are available to you in Form Editing Mode from the Add New Field pull-down menu. In almost all editing sessions you'll find a need to manually add a field to a form. If using Form Field Recognition, you may add only a few form objects. If you manually create fields on a form, you'll find frequent uses for all the form tools you select from the Add New Field menu.

### Assigning Form Field Properties

Field Properties provide you with a number of options for setting field attributes for all the form field types. There are a number of common properties that all fields share such as field names, appearances, and actions choices, and there are a number of properties that are unique among the various field types.

In Acrobat X you have two different properties environments. When in Form Editing Mode you add a new field to a document, an abbreviated properties Wizard helps you identify essential properties for new fields added to a form. For all field types other than radio buttons, your properties choices are limited to typing a name for the new field. With radio buttons you have an additional choice for adding fields to a group.

When in Form Editing Mode or Viewer mode, you can open a context menu on a field and choose Properties. This choice provides you with a much more expanded version of properties choices. In the Properties dialog box, you choose options from several different panes. Depending on the field type you create, the panes in the Properties dialog box vary for different field types. Some field properties are common among several fields, while other properties are unique to each field type.

To open the Properties dialog box, click a field in Form Editing Mode or use the Select Object tool in Viewer mode and click a field. Open a context menu and choose Properties. If opening the Properties on a text field, the Text Field Properties dialog box opens, as shown in Figure 30.15.
Chapter 30: Understanding Acrobat Form Tools

**Tip**
When creating fields in Form Editing Mode, click Show All Properties in the abbreviated properties window to open the expanded properties dialog box.

![Figure 30.15](image)

When you open the Properties dialog box on a text field, the General field properties appear as the default.

**Exploring the General properties tab**
The General properties tab is the default tab where general properties are assigned. These properties are common to all field types. The properties include:

- **Name.** By default, Acrobat adds a name in the Name field. As a matter of practice you should type a descriptive name in the Name text box. Don’t use names with spaces, and try to use parent/child names for fields in common groups. A parent/child name might appear as item.1, item.2, item.3, and so on; or you might have client.first, client.last, client.address, and so on.

- **Tooltip.** Type a name, and when the cursor is placed over the field in Preview mode, the text appears as a tooltip below the Hand tool cursor.

- **Form Field.** From the pull-down menu, make choices for visibility and printing. By default, the field is visible and prints when the file is printed.

- **Orientation.** A field and a field’s contents can be rotated in 90-degree rotations. By default, fields are at a 0 (zero)-degree rotation. Select from 90, 180, and 270 to rotate fields in fixed rotations.

- **Read Only.** When a field is marked as Read Only, the field is not editable. The user is locked out of the field. A Read Only field might be something you use to show fixed price costs where you don’t want users changing a fixed purchase price on an order.
Part VI: Using Acrobat PDF Forms

form. Another example is a value that is pre-populated from a database or with fields that show results of other calculated data.

- **Required.** If a field needs to be filled in before the data is submitted, select the Required box.
- **Locked.** Locking a field prevents the field from being moved. You can still type data in the field or make a choice from options for other fields. This item is used to fix fields in position as you edit a form.

**Reviewing Appearance properties**

The Appearance tab relates to form field appearances. The rectangles you draw can be assigned border colors and content fills. The text added to a field box or default text that you use for a field can be assigned different fonts, font sizes, and font colors. These options exist in the Appearance properties for all field types except barcode fields (barcode fields don’t have an Appearance tab). Figure 30.16 shows the Appearance properties for a selected text field.

**FIGURE 30.16**

Click the Appearance tab for any field properties and make choices for the appearance of fields and text.

The Appearance options include the following:

- **Border Color.** The keyline created for a field is made visible with a rectangular border assigned by clicking the Border Color swatch and choosing a color.
- **Background Color.** The field box can be assigned a background color. If you want the field box displayed in a color, enable this option, click the color swatch next to it, and choose a color the same way you do for the borders. When the check box is disabled, the background appears transparent.
Chapter 30: Understanding Acrobat Form Tools

- **Line Thickness.** Options are the same as those available for link rectangles. Select the pull-down menu and choose from Thin, Medium, or Thick. The pull-down menu is grayed out unless you first select a Border Color.

- **Line Style.** You can choose from five style types from the pull-down menu. The Solid option shows the border as a keyline at the width specified in the Width setting. Dashed shows a dashed line; Beveled appears as a box with a beveled edge; Inset makes the field look recessed; and Underline eliminates the keyline and shows an underline for the text across the width of the field box. See Figure 30.17 for an example of these style types.

- **Font Size.** Depending on the size of the form fields you create, you may have a need to choose a different point size for the text. The default is Auto, which automatically adjusts point sizes according to the height of the field box. Choices are available for manually setting the point size for text ranges between 2 and 300 points.

![FIGURE 30.17](image)

Five choices for a border style are available in the Appearance tab when selecting from the Line Style pull-down menu.

- **Text Color.** If you identify a color for text by selecting the swatch adjacent to Text Color, the field contains the end user supplies change to the selected color.

- **Font.** From the pull-down menu, select a font for the field data. All the fonts installed in your system are accessible from the pull-down menu. When designing forms for screen displays, try to use sans serif fonts for better screen views.

The Appearance settings are identical for all field types except Digital Signature fields, Radio Button fields, Check Box fields, and Barcode fields. The Radio Button and Check Box fields use fixed fonts for displaying characters in the field box. You choose what characters to use in the Options tab. When creating Radio Button and Check Box fields, you don’t have a choice for Font in the Appearance properties. By default, the Adobe Pi font is used.
Part VI: Using Acrobat PDF Forms

Exploring the Options properties
The Options tab provides selections for specific attributes according to the type of fields you add to a page. Options are available for all fields except the Digital Signatures field. Options tab attributes for the other six field types include options for text, radio buttons, combo and list boxes, and buttons.

Looking at text options
When you use the Text Field tool to create a field and then click the Options tab, the Properties window appears, as shown in Figure 30.18.

![Figure 30.18: The Options settings in the Text Field Properties dialog box](image)

Each of the following attribute settings is optional when creating text fields:

- **Alignment.** The Alignment pull-down menu has two functions. First, any text entered in the Default field is aligned according to the option you specify from the pull-down menu choices. Alignment choices include Left, Center, and Right. Second, regardless of whether text is used in the Default field, when the end user fills out the form the cursor is positioned at the alignment selected from the pull-down menu choices. Therefore, if you select Center from the Alignment options, the text entered when filling out the form is centered within the field box.
Chapter 30: Understanding Acrobat Form Tools

- **Default Value.** The Default Value field can be left blank, or you can enter text that appears in the field when viewing the form. The Default item has nothing to do with the name of the field. This option is used to provide helpful information when the user fills out the form data. If no text is entered in the Default field, when you return to the form, the field appears empty. If you enter text in the Default field, the text you enter appears inside the field box and can be deleted, edited, or replaced.

- **Multi-line.** If your text field contains more than one line of text, select the Multi-line option. When you press the Return key after entering a line of text, the cursor jumps to the second line, where additional text is added to the same field. Multi-line text fields might be used, for example, as an address field to accommodate a second address line.

- **Scrolling long text.** If Multi-line is selected and text entries exceed the height of the field, you may want to add scroll bars to the field. Enable the check box to permit users to scroll lines of text. If the check box is disabled, users won’t be able to scroll, but as text is added, automatic scrolling accommodates the amount of text typed in the field.

- **Allow Rich Text Formatting.** When you check this box, users can style text with bold, italic, and bold italic font styles. You may want to enable the check box if you want users to emphasize a field’s contents.

- **Limit of [ ] characters.** The box for this option provides for user character limits for a given field. If you want the user to add a state value of two characters, for example, check the box and type 2 in the field box. If the user attempts to go beyond the limit, a system warning beep alerts the user that no more text can be added to the field.

- **Password.** When this option is enabled, all the text entered in the field appears as a series of asterisks when the user fills in the form. The field is not secure in the sense that you must have a given password to complete the form; it merely protects the data entry from being seen by an onlooker.

- **Field is used for file selection.** This option permits you to specify a file path as part of the field’s value. The file is submitted along with the form data. Be certain to enable the Scrolling long text option described earlier in this list to enable this option.

- **Check spelling.** Spell checking is available for comments and form fields. When the check box is enabled, the field is included in a spell check. This can be helpful so the spell-checker doesn’t get caught up with stopping at proper names, unique identifiers, and abbreviations that may be included in those fields.

- **Comb of [ ] characters.** When you create a text field box and enable this check box, Acrobat automatically creates a text field box with preset spacing according to the value you supply in the Characters field box. For example, if you set the value of the characters to 7, the spacing between the characters when data is added to the form spaces the characters equidistant to fit seven characters for the field size. Setting a lower value adds more space between characters, and adding higher values reduces space between characters. In Figure 30.19 you can see a comb field designed for
Part VI: Using Acrobat PDF Forms

seven characters. Be certain to disable all other check boxes. You can set the align-
ment of the characters by making a choice from the alignment pull-down menu, but 
all other check boxes need to be disabled to access the Comb of check box.

FIGURE 30.19
A comb field designed for seven characters

| service code |
| 1 | 2 | 3 | 4 | 5 | 6 | 7 |

Note
Comb fields are limited to single characters. If you need to create comb fields where two characters are con-
tained in each subdivision, you need to create separate field boxes for each pair of characters.

Tip
When you create a new form and use auto field detection, Acrobat can pick up comb fields and format them properly. Be certain to carefully design comb fields with hatch marks spaced the same height and distance in your authoring program, and you’ll find Acrobat doing a good job in formatting the fields as comb fields. If hatch mark line widths, distances, or sizes vary, Acrobat won’t recognize the fields as comb fields.

Selecting check box and radio button options
Check boxes and radio buttons have similar Options attribute choices. When you select either field and click the Options tab, the settings common to both field types include:

• Button/Check Box Style. If a radio button is selected, the title is Button Style as shown in Figure 30.20. If the field is a check box, the title is listed as Check Box Style. From the pull-down menu, you select the style you want to use for the check mark inside the radio button or check box field.

• Button/Export Value. When creating either a check box or radio button, use the same field name for all fields in a common group where you want one radio button/check box enabled while all the other radio buttons/check boxes are disabled. To dis-
tinguish the fields from each other, add a Button Style (radio buttons) Export Value (check boxes) that differs in each field box. You can use export values such as Yes and No or other text, or number values such as 1, 2, 3, 4, and so on.
Chapter 30: Understanding Acrobat Form Tools

**FIGURE 30.20**
You can choose various options for radio buttons and check boxes, including those for the style of the check marks or radio buttons.

The creation of radio buttons and check boxes on Acrobat forms has been confusing to many users, and users often inappropriately create workarounds for check boxes and radio buttons to toggle them on and off. To help eliminate confusion, notice the Options properties in Figure 30.20 include a help message informing you to name fields the same name but use different export values.

- **Button/Check box is checked by default.** If you want a default value to be applied for either field type (for example, Yes), enter the export value and select the box to make the value the default. One distinction appears in the Options dialog box between radio buttons and check boxes. The second check box in the radio button properties is unique to radio buttons.

- **Buttons with the same name and value are selected in unison (applies to radio buttons only).** For data export purposes, you’ll want to add a different button/export value for each radio button and check box. If you don’t need to export data to a database with unique export values for each radio button, you can add radio buttons to a page with the same export values and, by default, when a user clicks one radio button all other radio buttons are disabled. If you want all radio buttons to be selected when clicking one button in a group having the same name and export value, check this check box.

The Button/Check Box Style selection from the pull-down menu in both field types provides identical appearances. The styles are shown in Figure 30.21.
Part VI: Using Acrobat PDF Forms

**FIGURE 30.21**
Six icon options are available for check boxes and radio buttons.

Choosing combo box and list box options
Combo boxes enable you to create form fields with a list of selections appearing in a pull-down window. The user completing a form makes a selection from the menu items. If all items are not visible, the menu contains scroll bars made visible after selecting the down-pointing arrow to open the menu. A list box is designed as a scrollable window with an elevator bar and arrows as you see in authoring application documents, as shown in Figure 30.22.

**FIGURE 30.22**
View the combo box items by clicking the down arrow. After you open the menu, the scroll bars become visible. List boxes enable users to select multiple items in the scrollable window.

The two field types differ in several ways. First, combo boxes require less space for the form field. The combo box menu drops down from a narrow field height where the menu options are shown. List boxes require more height to make them functional to the point where at least two or three options are in view before the user attempts to scroll the window. Second, you can select only one menu option from a combo box. List boxes enable users to select multiple items. Finally, combo boxes can be designed for users to add text for a custom choice by
Chapter 30: Understanding Acrobat Form Tools

editing any of the menu items. List boxes provide no option for users to type text in the field box, and the menu items are not editable.

The data exported with the file include the selected item from the combo boxes and all selected items for list boxes. The item choices and menu designs for the field types are created in the Options tab for the respective field type. Attributes for list boxes, shown in Figure 30.23, are also available for combo boxes.

**FIGURE 30.23**
The Options settings for list boxes have common properties also found in combo boxes.

The options include:

- **Item.** You enter the name of an entry you want to appear in the scrollable list in this field.
- **Export Value.** When the data are exported, the name you enter in this field box is the exported value. If the field is left blank, the exported value is the name used in the item description typed in the Item field. If you want different export values than the name descriptions, type a value in this field box. As an example, suppose you created a consumer satisfaction survey form. In that form, the user can choose from list items such as Very Satisfied, Satisfied, and Unsatisfied, and you’ve specified the export values for these items to be 1, 2, and 3, respectively. When the data are analyzed, the
Part VI: Using Acrobat PDF Forms

frequency of the three items would be tabulated and defined in a legend as 1=Very Satisfied, 2=Satisfied, and 3=Unsatisfied.

- **Add.** After you enter the Item and Export Values, click the Add button to place the item in the Item List. After adding an item, you can return to the Item field and type a new item in the field box and, in turn, a new export value.

- **Item List.** As you add items, the items appear in a scrollable list window. To edit a name in the list window, delete the item, type a new name in the Item text box, and then click the Add button to add the newly edited item back in the list.

- **Delete.** If an item has been added to the list and you want to delete it, first select the item in the list. Click the Delete button to remove it from the list.

- **Up/Down.** Items are placed in the list according to the order in which they are entered. The order displayed in the list is shown in the combo box or list box when you return to the document page. If you want to reorganize items, select the item in the list and click the Up or Down button to move one level up or down, respectively. To enable the Up and Down buttons, the Sort Items option must be disabled.

- **Sort items.** When checked, the list is alphabetically sorted in ascending order. As new items are added to the list, the new fields are dynamically sorted while the option is enabled.

- **Multiple selection (List box only).** Any number of options can be selected by using modifier keys and clicking on the list items. Use Shift+click for contiguous selections and Ctrl/⌘+click for noncontiguous selections. This option applies only to list boxes.

- **Commit selected value immediately.** The choice made in the field box is saved immediately. If the check box is disabled, the choice is saved after the user exits the field by tabbing out or clicking the mouse cursor on another field or outside the field.

With the exception of the multiple selection item, the preceding options are also available for combo boxes. In addition to these options, combo boxes offer two more items that include:

- **Allow user to enter custom text.** The items listed in the Options tab are fixed in the combo box on the Acrobat form by default. If this check box is enabled, the user can create a custom value. Acrobat makes no provision for some items to be edited, and others are locked out from editing.

- **Check spelling.** Spell-checking is performed when a user types in a custom value. As text is typed, the spelling is checked.

**Selecting button options**

Buttons differ from all other fields when it comes to appearance. You can create and use custom icons for button displays from PDF documents or file types compatible with Convert to PDF from File. Rather than entering data or toggling a data field, buttons typically execute an action. You might use a button to clear a form, export data, import data from a data file, or use buttons as navigation links. When you add a button to a page, the Options tab attributes change to those shown in Figure 30.24.
Chapter 30: Understanding Acrobat Form Tools

**FIGURE 30.24**
The Options tab for the Button field properties includes options for button face displays and several different mouse behaviors.

When you create a button, you make choices from the Options tab for the highlight view of the button, the behavior of the mouse cursor, and the text and icon views. The Options attributes for buttons are as follows:

- **Layout.** Several views are available for displaying a button with or without a label, which you add in the Label field described later in this list. The choices from the pull-down menu for Layout offer options for displaying a button icon with text appearing at the top, bottom, left, or right side of the icon, or over the icon. Figure 30.25 shows the different Layout options.

- **Behavior.** The Behavior options affect the appearance of the button when the button is clicked. The None option specifies no highlight when the button is clicked. Invert momentarily inverts the colors of the button when clicked. Outline displays a keyline border around the button, and Push makes the button appear to move in on Mouse Down and out on Mouse Up.

- **Icon and Label State.** Three choices are available in the list when you select Push in the Behavior pull-down menu. Up displays the highlight action when the mouse button is released. Down displays the highlight action when the mouse button is pressed. Rollover changes the icon when a second icon has been added to the rollover option. When the user moves the mouse cursor over the button without clicking, the image changes to the second icon you choose — much like a rollover effect you see on Web pages.
Part VI: Using Acrobat PDF Forms

FIGURE 30.25
The Layout options include Label only; Icon only; Icon top, label bottom; Label top, icon bottom; Icon left, label right; Label left, icon right; and Label over icon.

- **Label.** If you've selected a layout type that includes a label, type text in the field box for the label you want to use. Labels are shown when one of the options for the layout includes a label view with or without the icon.

- **Choose Icon.** When you use an icon for a button display, click Choose Icon to open the Select Icon dialog box. In the Select Icon dialog box, use a Browse button to open a navigation dialog box where you locate a file to select for the button face. The file can be a PDF document or a file compatible with converting to PDF from within Acrobat. The size of the file can be as small as the actual icon size or a letter-size page or larger. Acrobat automatically scales the image to fit within the form field rectangle drawn with the Button tool. When you select an icon, it is displayed as a thumbnail in the Select Icon dialog box.

**Tip**
An icon library can be easily created from drawings using a font such as Zapf Dingbats or Wingdings or patterns and drawings from an illustration program. Create or place images on several pages in a layout application. Distill the file to save out as a multiple-page PDF document. When you select an icon to use for a button face, the Select Icon dialog box enables you to scroll pages in the document. You view each icon in the Sample window as a thumbnail of the currently selected page. When the desired icon is in view, click OK. The respective page is used as the icon.

- **Clear.** You can eliminate a selected icon by clicking the Clear button. Clear eliminates the icon without affecting any text you added in the Layout field box.

- **Advanced.** Notice the Advanced button at the top of the Options tab. Clicking the Advanced button opens the Icon Placement dialog box, where you select attributes related to scaling an icon. You can choose from icon scaling for Always, Never, Icon is
Chapter 30: Understanding Acrobat Form Tools

Too Big, Icon is Too Small to fit in the form field. The Scale option offers choices between Proportional and Non-proportional scaling. Click Fit to bounds to ensure the icon placement fits to the bounds of the field rectangle. Sliders provide a visual scaling reference for positioning the icon within a field rectangle.

Choosing barcode options

Barcode fields have unique options designed to work with barcode scanners. You have options from pull-down menus and pop-up dialog boxes opened from buttons, as shown in Figure 30.26. In order to make choices for the items in the Options pane in the Barcode Field Properties dialog box, you need to know what parameters are used by your barcode scanner, fax server, or document scanner. Setting the options requires reviewing the documentation supplied by the hardware used to scan barcodes.

![Figure 30.26](image)

The Options tab for barcodes requires setting options conforming to the tools you use to scan barcodes.

Barcodes need to calculate the data in the form in order to form the barcode. When you create barcode fields, the fields should be created with sample data on a form in order for the barcode to perform the necessary calculation to form the bar code image. You’ll find at times that the barcode field isn’t large enough to accommodate all data. If this occurs, you need to make the field larger or eliminate some data from the barcode.
Part VI: Using Acrobat PDF Forms

Cross-Reference
Managing the data is handled in the Value tab. See the section “Accessing Barcode properties” later in this chapter.

Setting Actions properties
The Actions tab enables you to set an action for any one of the eight field types; the attribute choices are identical for all fields. The same action items available for links, bookmarks, and page actions are also available to form fields. Click the Actions tab and the pane changes, as shown in Figure 30.27.

Cross-Reference
For more information on selecting action types, see Chapter 21.

From the Select Trigger pull-down menu, you make choices for different mouse behaviors that are assigned to invoke the action. From the menu options you have choices for:

- **Mouse Up.** When the user releases the mouse button, the action is invoked.
- **Mouse Down.** When the user presses the mouse button, the action is invoked.
- **Mouse Enter.** When the user moves the mouse cursor over the field, the action is invoked.
- **Mouse Exit.** When the user moves the mouse cursor away from the field, the action is invoked.
- **On Focus.** Specifies moving into the field boundaries through mouse movement or by tabbing to the field. As the cursor enters the field, the action is invoked.
- **On Blur.** Specifies moving away from the field boundaries through mouse movement or by tabbing to the field. As the cursor exits the field, the action is invoked.

Actions assigned to the cursor movements are similar to those in the context of creating links. You first select the trigger, and then select an action type from the Select Action pull-down menu. Click the Add button to add the action to the Actions list.

The action is assigned to the mouse cursor option when you click Add. The default is Mouse Up. When Mouse Up is selected, the action is invoked when the mouse button is released.

Caution
Trigger choices other than Mouse Up may sometimes complicate filling in form fields for end users. Just about any program dealing with link buttons has adopted the Mouse Up response to invoke an action. Many users often click down, think about what they are doing, and then move the mouse away without releasing the button. This behavior enables the user to change his/her mind at the last minute. Deviating from the adopted standard might be annoying for a user.
When you click the Add button, a dialog box specific to the action type you are adding opens. The actions listed in this dialog box are the same as those in the Link Properties dialog box discussed in Chapter 21. Turn back to Chapter 21 for examples of how the following action types work. A few of the more important action types used with form fields include importing form data, resetting a form, submitting a form, and showing and hiding a field.

**Importing form data**

You can export the raw data from a PDF file as a Form Data File (FDF), XDF, XML, or TXT that can later be imported into other PDF forms. To import data, you use a menu command from the list of action types (Import Form Data) or create a JavaScript. Rather than retyping the data in each form, you can import the same field data into new forms where the field names match exactly. Therefore, if a form contains field names such as First, Last, Address, City, State, and so on, all common field names from the exported data can be imported into the current form. Acrobat ignores those field names without exact matches.

**PDF Workflow**

The Import Data command (in the Forms panel, select More ▸ Manage Form Data ▸ Import Data) enables you to develop forms for an office environment or Web server where the same data can easily be included in several documents. When designing forms, using the same field names for all common data is essential. If you import data and some fields remain blank, recheck your field names. You can edit any part of a form design or action to correct errors.
Part VI: Using Acrobat PDF Forms

Using the Acrobat Data Search

When a data file is identified for an import action, Acrobat looks to the location you specified when creating the action. Acrobat also searches other directories for the data. On the Macintosh, Acrobat looks to the Reader and Acrobat User Data directories for the data file. On Windows, Acrobat looks to the Acrobat directory, Reader directory, current directory, Windows directory, and Application Data directory. If Acrobat cannot find the data file, a dialog box opens containing a Browse button to prompt the user to locate the data file.

Resetting a form

This action is handy for forms that need to be cleared of data and resubmitted. When the Reset a form action is invoked, data fields specified for clearing data when the field was added are cleared. When you select Reset a form and click the Add button, the Reset a Form dialog box opens. You make choices in this dialog box for what fields you want to clear. Click the Select All button and all data fields are cleared when a user clicks on the button you assign with a Reset a form action. When you use this action, it's best to associate it with Mouse Up to prevent accidental cursor movements that might clear the data and require the user to begin over again. Reset a form can also be used with a Page Action command. If you want a form to be reset every time the file is opened, the latter may be a better choice than creating a button.

Tip

When you design a form and view the form in either Form Editing or Viewer mode, open the Forms panel and click Clear Form to reset a form. Using this command is handy if you have not yet added a Reset button to your form.

Cross-Reference

For more information on using page actions, see Chapter 21.

Submitting a form

Acrobat allows Form data to be emailed, submitted to Acrobat.com, or submitted to Web servers. You can design forms so users of the Adobe Reader software can submit data via email or to Web servers. When using the Submit a form action, you have access to options for the type of data format you want to submit.

Cross-Reference

For more information on submitting form data, see Chapter 31.

Looking at Format properties

The General, Appearance, and Actions tabs are available for all field types. Option attributes are available for all field types except digital signatures. The options vary significantly depending on which field type is used. For a quick glance at the tab differences according to field type, take a look at Table 30.2.
Chapter 30: Understanding Acrobat Form Tools

### TABLE 30.2
Tab Options for Field Types in the Field Properties Window

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Appearance</th>
<th>Options</th>
<th>Actions</th>
<th>Format</th>
<th>Validate</th>
<th>Calculate</th>
<th>Selection Change</th>
<th>Signed</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check Box</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Combo Box</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List Box</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radio Button</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Signature</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Barcode</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

As shown in Table 30.2, the Format, Validate, and Calculate tab options are available only for Combo Box and Text field types. To access the Format tab, select either of these field types. The Format options are the same for both field types.

When you click the Format tab, you’ll find a pull-down menu for selecting a format category. To define a format, open the Select format category and choose from the menu choices the format you want to assign to the Text or Combo Box field. As each item is selected, various options pertaining to the selected category appear directly below the pull-down menu. When you select Number from the menu choices, the Number Options appear as shown in Figure 30.28.

The Select format category menu options include:

- **None.** No options are available when None is selected. Select this item if no formatting is needed for the field. An example of where None applies would be a text field where you want text data such as name, address, and so on.

- **Number.** When you select Number, the Number Options choices appear below the Select format category pull-down menu. The options for displaying numeric fields include defining the number of decimal places, indicating how the digits are separated (for example, by commas or by decimal points), and specifying any currency symbols. The Negative Number Style check boxes enable you to display negative numbers with parentheses and/or red text.

- **Percentage.** The number of decimal places you want to display for percentages is available when you select Percentage from the pull-down menu. The options are listed for number of decimal places and the separator style.
When you choose either Combo Box or Text as the field type, you can select data format options from the Format tab.

- **Date.** The date choices offer different selections for month, day, year, and time formats.
- **Time.** If you want to eliminate the date and identify only time, the Time category enables you to do so, offering choices to express time in standard and 24-hour units and a custom setting where custom formats are user-prescribed in a field box.
- **Special.** The Special category offers formatting selections for Social Security number, zip code, extended zip codes, phone numbers, and an arbitrary mask. When you select Arbitrary Mask, a field box is added where you define the mask. The acceptable values for setting up an arbitrary mask include:
  - **A.** Add A to the Arbitrary Mask field box, and only the alphabetical characters A–Z and a–z are acceptable for user input.
  - **X.** When you add X to the Arbitrary Mask field box, most printable characters from an alphanumeric character set are acceptable. ANSI values between 32–166 and 128–255 are permitted. (To learn more about what ANSI character values 32–166 and 128–255 are translated to, search the Internet for ANSI character tables. You can capture Web pages and use the tables as reference guides.)
Chapter 30: Understanding Acrobat Form Tools

- **0.** The letter 0 accepts all alphanumeric characters (A–Z, a–z, and 0–9).
- **9.** If you want the user to be limited to filling in numbers only, enter 9 in the Arbitrary Mask field box.
- **Custom.** Custom formatting is available by using a JavaScript. To edit the JavaScript code, click the Edit button and create a custom format script. The JavaScript Editor dialog box opens, where you type the code. As an example of using a custom JavaScript, assume that you want to add leading zeros to field numbers. You might create a JavaScript with the following code:

```javascript
event.value = "000" + event.value;
```

The preceding code adds three leading zeros to all values supplied by the end user who completes the form field. If you want to add different characters as a suffix or prefix, enter the values you want within the quotation marks. To add a suffix, use

```javascript
event.value = event.value + "000";
```

**Selecting Validate properties**

Validate helps ensure proper information is added on the form. If a value must be within a certain minimum and maximum range, select the radio button for validating the data within the accepted values. (See Figure 30.29.) The field boxes are used to enter the minimum and maximum values. If the user attempts to enter a value outside the specified range, a warning dialog box opens, informing the user that the values entered on the form are unacceptable.

**Figure 30.29**

Validate is used with Combo Box and Text field types to ensure acceptable responses from user-supplied values.
Part VI: Using Acrobat PDF Forms

Selecting the Run custom validation script radio button and clicking the Edit button enable you to add a JavaScript. Scripts that you may want to include in this window would be those for validating comparative data fields. A password, for example, may need to be validated. If the response does not meet the condition, the user is denied access to supplying information in the field.

Choosing Calculate properties
The Calculate tab (supported in Text and Combo fields) in the Field Properties window enables you to calculate two or more data fields. You can choose from preset calculation formulas or add a custom JavaScript for calculating fields, as shown in Figure 30.30.

The preset calculation formulas are limited to addition, multiplication, averaging, assessing the minimum in a range of fields, and assessing the maximum in a range of fields. For all other calculations you need to select the Simplified field notation or Custom calculation script radio button and click the Edit button. In the JavaScript Editor, you write JavaScripts to perform other calculations not available from the preset formulas. Simplified field notation is written in the JavaScript editor and follows syntax similar to writing formulas in spreadsheets. JavaScripts, also written in the JavaScript Editor, require you to know JavaScript as it is supported in Acrobat.

**FIGURE 30.30**
The Calculate tab offers options for calculating fields for summing data, multiplying data, and finding the average, minimum, and maximum values for selected fields. In addition, you can add custom calculations by writing JavaScripts.
Cross-Reference
For more information on calculating data, see Chapters 31 and 32.

Employing the Selection Change properties
The Selection Change tab, shown in Figure 30.31, is available for List Box fields only. If a list box item is selected, and then a new item from the list is selected, JavaScript code can be programmed to execute an action when the change is made. As with the other dialog boxes, clicking the Edit button opens the JavaScript Editor dialog box, where you create the JavaScript code.

A variety of uses exist for the Selection Change option. You might want to create a form for consumer responses for a given product — something such as an automobile. Depending on information preceding the list box selection, some options may not be available. For example, a user specifies “four-door automobile” as one of the form choices, and then from a list, that user selects “convertible.” If the manufacturer does not offer a convertible for four-door automobiles, then through use of a JavaScript in the Selection Change tab, the user is informed that this selection cannot be made based on previous information supplied in the form. The displayed warning could include information on alternative selections that the user could make.

FIGURE 30.31
The Selection Change tab is available only for List Box fields. When using a Selection Change option, you’ll need to program JavaScript code to reflect the action when a change in selection occurs.

Using the Digital Signature fields properties
The Digital Signature tool enables you to create a field used for electronically signing a document with a digital signature. The Signed tab offers options for behavior with digital signatures as follows:
Part VI: Using Acrobat PDF Forms

- **Nothing happens when signed.** As the item description suggests, the field is signed but no action takes place upon signing.

- **Mark as read-only.** When signed, the selected fields are changed to read-only fields, locking them against further edits. You can mark all fields by selecting the radio button and choosing All fields from the pull-down menu. Choose All fields except these to isolate a few fields not marked for read-only, or select just these fields to mark a few fields for read-only.

- **This script executes when the field is signed.** Select the radio button and click the Edit button to open the JavaScript Editor. Write a script in the JavaScript Editor that executes when the field is signed.

Digital signatures can be used to lock data fields. You can also use them to indicate approval from users or PDF authors, or you may want to display a message after a user signs a form. In Figure 30.32, a JavaScript was added to the Digital Signature Signed Properties.

The script in this example instructs a user to print the form and hand-deliver it to the accounting department. A dialog box opens after the user signs the form.

**Cross-Reference**

For setting up digital signatures and finding out more information related to signing documents, see Chapter 24.

**FIGURE 30.32**

For custom actions when a user signs a form, use a JavaScript.
Chapter 30: Understanding Acrobat Form Tools

Accessing Barcode properties

The unique property settings in the Barcode field are located in the Value tab. Options in this tab are available only with barcode fields, as shown in Figure 30.33. You have options for Encoding from a pull-down menu offering a choice between XML and Tab Delimited data.

Click the Pick button and the Field Selection dialog box opens as shown in Figure 30.34. You use this dialog box to determine what field data are added to the barcode. Uncheck those items you don’t want added, such as buttons that invoke actions, temporary calculation fields, and so on. The Include field names text box offers an option to include field names along with the data in the barcode.

An additional box appears for adding a Custom calculation script. Click the radio button and click Edit to open the JavaScript Editor.

FIGURE 30.33
The Value tab appears only in Barcode fields.
Part VI: Using Acrobat PDF Forms

**FIGURE 30.34**
Click Pick and check the items you want to appear as data in the barcode.

---

**Managing Fields**

For purposes of explanation, I’ll use the term *managing fields* to mean dealing with field duplication, deleting fields, and modifying field attributes. After you create a field on a PDF page, you may want to alter its size, position, or attributes. Editing form fields in Acrobat is made possible by using one of several menu commands or returning to the respective Field Properties window. This kind of editing can be performed in Form Editing Mode or Viewer mode.

**Organizing fields**

To edit a form field’s properties, use the Select Object tool. If you work in Form Editing Mode, the Select Object tool is the tool selection by default. Unless you choose a tool from the Add New Field menu, the only tool available to you without using a key modifier is the Select Object tool. In Viewer mode, you need to click the Select Object tool to make it the active tool. In either mode, open a context menu and choose Properties to open a field’s properties. Alternately, you can also double-click a field to open the properties dialog box.

When you select multiple fields and choose Properties from the context-sensitive menu, options in the General tab, the Appearance tab, and the Actions tab are available for editing. Specific options for each different field type require that you select only common field types. For example, you can edit the appearance settings for a group of fields where the field types are different. However, to edit something like radio button field options for check mark style, you need to select only radio button fields in order to gain access to the Options tab.
Tip
If the fields you want to select are located next to each other or you want to select many fields, use the Select Object tool and drag a marquee through the fields to be selected. When you release the mouse button, the fields inside the marquee and any fields intersected by the marquee are selected. The marquee does not need to completely surround fields for selection — just include a part of the field box within the marquee.

Renaming fields
When you create a field in Form Editing Mode, an abbreviated properties window opens where you can name a field and set field attributes as a required field — meaning the field must be filled in before the data can be submitted. If you open a context menu in either Form Editing Mode or Viewer mode, the same properties window opens offering you the same options choices as shown in Figure 30.35.

Duplicating fields
You can duplicate a field by selecting it and holding down the Ctrl/Option key while clicking and dragging the field box. Fields can also be copied and pasted on a PDF page, between PDF pages, and between PDF documents. Select a field or multiple fields, and then choose Edit•Copy. Move to another page or open another PDF document and choose Edit•Paste. The field names and attributes are pasted together on a new page. Copying and pasting fields works well while in Form Editing or Viewer mode.

Tip
To ensure that field names are an exact match between forms, create one form with all the fields used on other forms. Copy the fields from the original form and paste the fields in other forms requiring the same fields. By pasting the fields, you ensure all field names are identical between forms and can easily swap data between them. If you have JavaScripts at the document level, use the Document•Replace Pages command when you want to populate a form having a similar design to an original form.

Moving fields
You can relocate fields on the PDF page by using the Select Object tool and clicking and dragging the field to a new location. To constrain the angle of movement, select a field with the Select Object tool, press the Shift key, and drag the field to a new location. For precise
movement, use the arrow keys to move a field box left, right, up, or down. When using the arrow keys to move a field, be certain to not use the Shift key while pressing the arrow keys because doing so resizes field boxes as opposed to moving them.

Deleting fields
You delete fields from PDF documents in three ways. Select the field and press the Backspace key (Windows) or Delete key (Mac). You can also select the field and then choose Edit ➤ Delete or open a context menu and choose Edit ➤ Delete. In all cases, Acrobat removes the field without warning. If you inadvertently delete a field, you can Undo the operation by choosing Edit ➤ Undo.

Aligning fields
Even when you view the grids on the PDF page, aligning fields can sometimes be challenging. Acrobat simplifies field alignment by offering menu commands for aligning the field rectangles at the left, right, top, and bottom sides, as well as for specifying horizontal and vertical alignment on the PDF page. To align fields, select two or more fields and then open a context menu and select Align ➤ Distribute Center, as shown in Figure 30.36. The alignment options for Left, Right, Top, Bottom, Horizontally, and Vertically appear in a submenu.

![FIGURE 30.36](image)

Open a context menu using the Select Object tool on one field in a group of selected fields and choose Align from the menu.
Chapter 30: Understanding Acrobat Form Tools

Acrobat aligns fields according to the first field selected (the anchor field appearing with a red highlight). In other words, the first field’s vertical position is used to align all subsequently selected fields to the same vertical position. The same holds true for left, right, and top alignment positions. When you use the horizontal and vertical alignments, the first field selected determines the center alignment position for all subsequently selected fields. All fields are center aligned either vertically or horizontally to the anchor field.

**Tip**
Fields are aligned to an anchor field when multiple fields are selected and you use the align, center, distribute, and size commands. The anchor field appears with a red border whereas the remaining selected field highlights are blue. If you want to change the anchor (the field to be used for alignment, sizing, and so on), click any other field in the selected group. Unlike other multiple object selections, you don’t need to use the Shift key when selecting different fields from among a group of selected fields. All fields remain selected until you click outside the field boundaries of any selected field.

You can distribute fields on a PDF page by selecting multiple fields and choosing Distribute (Vertically or Horizontally) from the same submenu. Select either Horizontally or Vertically for the distribution type. The first and last fields in the group determine the beginning and ending of the field distribution. All fields within the two extremes are distributed equidistant between the first and last fields.

**Cross-Reference**
For an example of how to use the Distribute commands, see “Creating multiple copies of fields” later in this chapter.

Center alignment is another menu command available from a context menu. When you choose Center (Vertically or Horizontally) from the same submenu shown in Figure 30.36, the selected field aligns to the horizontal or vertical center of the page. Choose Both to align a field to the center of a page. If multiple fields are selected, the alignment options take into account the relative positions of the field boxes and center the selected fields as a group while preserving their relative positions.

**Sizing fields**
Field rectangles can be sized to a common physical size. Once again, the anchor field determines the size attributes for the remaining fields selected. To size fields, select multiple field boxes, and then open a context menu and choose Size Fields to Same Size and choose Width, Height, or Both from the submenu. To size field boxes individually in small increments, hold down the Ctrl/Option key and move the arrow keys. The Left and Right Arrow keys size field boxes horizontally, whereas the Up and Down arrow keys size field boxes vertically.

**Creating multiple copies of fields**
To create a table array, select fields either in a single row or single column and open a context menu. From the menu options, select Place Multiple Fields. The Create Multiple Copies of Fields dialog box opens, as shown in Figure 30.37. In the Create Multiple Copies of Fields dialog box,
Part VI: Using Acrobat PDF Forms

enter a value in the field box for Copy selected fields down (for creating rows of fields) or Copy selected fields across (to create columns of fields). In Figure 30.37, I created three fields and wanted my duplicated fields to be added below the top row. Notice when you make selections in the Create Multiple Copies of Fields dialog box with the Preview check box enabled, you see a dynamic preview in the document for how the fields appear when duplicated.

**Note**
You can also create a table array by first creating a single field and then selecting options for both Copy Selected Fields down and Copy Selected Fields across.

If you want to add both rows and columns, you can supply values in both field boxes for the desired number of columns and rows. The Change Width and Change Height field boxes enable you to adjust the field distance respective to each other — editing the values does not change the physical sizes of the fields. Click the Up/Down buttons for moving all fields vertically or the Left/Right buttons to move fields horizontally. When the preview box is enabled, you’ll see a preview of the duplicated rows and columns before you accept the attribute choices by clicking OK.

**FIGURE 30.37**
To create a table array, select a row or column of fields and open a context menu. Select Place Multiple Fields and make selections in the Create Multiple Copies of Fields dialog box for the number of rows or columns to be duplicated.
Chapter 30: Understanding Acrobat Form Tools

If, after you click OK, you need to polish the position of the new fields, you can move the top and bottom fields (for aligning single columns), then open a context menu and choose Align, Distribute, or Center Vertically (or Horizontally) — depending on whether you're adjusting a row or column.

When using the Distribute command, you can distribute only single rows or columns. If you attempt to select all fields in a table and distribute several rows or columns at once, the results render an offset distribution that most likely creates an unusable alignment.

**Duplicating fields**
Using the Place Multiple Fields menu command from a context menu enables you to create table arrays or individual columns or rows only on a single page. If you want to duplicate fields either on a page or through a number of pages, another menu command exists for field duplication.

You can use the Duplicate command to duplicate fields; however, in most circumstances when you want to duplicate a field, press the Ctrl/Option key and click+drag a field. The field and the properties are duplicated. If you need to change the field name, open the properties dialog box and edit the Name in the General properties.

**Setting attribute defaults**
If you spend time formatting attributes for field appearances, options, and actions, you may want to assign a default attribute set for all subsequent fields created with the same form tool. After creating a field with the attributes you want, open a context menu and select Use Current Properties as New Defaults. The properties options used for the field selected, when you choose the menu command, become a new default for that field type. As you change form tools and create different fields, you can assign different defaults to different field types.

**Setting field tab orders**
You have two options for setting the tab order on a form. This is one item you should address before saving your final edited form. You should be able to press the Tab key to enter the first field on a page and tab through the remaining fields in a logical order to make it easy for the end user to fill in your form. Before deploying your form, be sure to check the tab order.

The first option you have for setting Tab order is in the Pages panel. Enter Viewer mode and open the Pages panel. Open a context menu on the page where you want to set tab order. Select Properties from the menu options and the Page Properties dialog box opens, as shown in Figure 30.38. By default the Tab Order pane opens with options for setting tab order by making radio button selections.
Part VI: Using Acrobat PDF Forms

FIGURE 30.38
To set tab order, open the Pages panel and open a context menu on the page where you want to edit the tab order. Select Properties from the menu choices and click Tab Order in the Page Properties dialog box.

The options for setting tab order include the following:

- **Use Row Order.** Tabs through rows from left to right. If you want to change the direction for tabbing through fields, choose File -> Properties. Click Advanced in the left pane and select Right Edge from the Binding pull-down menu. When you select Use Row Order and the document binding is set to Right Edge, the tab order moves from right to left.

- **Use Column Order.** Tabs through columns from left to right, or right to left if you change the binding as described in the preceding bullet.

- **Use Document Structure.** When selecting this option, you first need to use a PDF document with structure and tags. The tab order is determined by the structure tree created by the original authoring application when the file was exported to PDF.

- **Unspecified.** The default for all documents you created in earlier versions of Acrobat that you open in Acrobat 6 through 8 have the Unspecified option selected. Unless you physically change the tab order to one of the preceding options, the tab order remains true to the order set in Acrobat 5 or earlier.

The order in which you create fields and add them to a page is recorded. If you happen to create a row of fields, and then change your mind and want to add a new field in the middle of the row, Acrobat tabs to the last field in the row from the last field created. Changing the tab orders in the Page Properties won’t help you fix the problem when the fields need to be reordered.

Fortunately, you do have more options for setting tab orders. The second method, and perhaps your best choice, is the Form Editing Mode for arranging fields in the proper tab order.
Tip

You can drag and drop fields in the Fields panel to change the tab order. Click a field in the Fields panel in Form Editing Mode and drag the field up or down in the Fields panel to change the tab order.

If you want to see a visual order of your fields on a form, open a context menu on any field and choose Show Tab Numbers. Each field displays the tab order number in the top-left corner of the field box as shown in Figure 30.39.

Summary

In this chapter, you learned some of the fundamentals for creating PDF forms.

- Acrobat forms are not scanned documents converted to PDF. They are dynamic and can include interactive elements, data fields, buttons, and JavaScripts.
- Automatic form fill-in is enabled in the Preferences dialog box. Form fields can be displayed on PDF pages with a highlight color to help identify field locations.
Part VI: Using Acrobat PDF Forms

- Data fields are created from many different field types including text, buttons, combo boxes, list boxes, signatures, check boxes, radio buttons, and barcodes.
- You set all data field attributes in the Field Properties window. Properties can be described for fields by selecting the tabs labeled Appearance, Options, Actions, Calculations, or other tabs associated with specific field types.
- Acrobat Pro and Standard have a Form Editing mode where you add field objects via a pull-down menu where the various form tools are selected.
- In Acrobat Pro and Standard, you edit forms in Form Editing Mode and fill in or check form functionality in Preview mode.
- You can edit fields with a context-sensitive menu. Acrobat has several editing commands used for aligning fields, distributing fields, and centering fields on a PDF page.
- Field duplication is handled in a context menu. You can duplicate fields on a page to create tables with the Place Multiple Fields command, or duplicate fields across multiple pages with the Duplicate command.
- The Fields panel dynamically lists all fields created in a PDF file. The panel menus and options can be of much assistance in editing field names and locating fields. The panel is in view only in Form Editing Mode.
- A form’s tab order can be easily reordered by dragging fields up and down in the Fields panel.